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Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 01: Computer Systems Components & their Functions

Introduction to computer (Week 1)

Topics Covered: Identification of basic computer components & their functions and Computer Devices.
Instruction:

e You should write your answers to the questions below in your notebook.

e You must give your notebook to the lab instructor for marking.

e Lab excercise2 will require the image of the motherboard available on the link
https://dcs.abu.edu.ng/courses/cosc101/ for reference.

e Lab excercise3 will require the use of a standard computer keyboard for illustration.

Lab Objectives:
The students should understand:

e The different types of computer casing.

e How to identify the Make or manufacturer of a system

e The Internal & External components of a computer systems

e The different ports available to a particular system and their functions

Lab Exercise 1:

Requirement: these lab exercises require a complete system with its internal components.

l1a). Identify the following:
i. The TYPE/MAKE AND MODEL of the computer you’re using. E.g. (HP — Pavilion, DV4,
laptop)
ii. LPT Ports, how many ports are there? Where are they located in your computer?
iii. COM ports. How many ports did you see?
iv. PS2 ports. What color is for Mouse & for Keyboard?
v. Where is the POWER LED located?
vi. The CD/DVD ROM. Is the ROM in your computer CD or DVD Writable?



1b). Functions and differences between COM and PS2 ports

any)

Port Function Unique characteristics (if

Lab Exercise 2: (Use an image not real Motherboard)

Instruction:

e You should write your answers to the questions below in your notebook.
* You must give your notebook to the lab instructor for marking.

Lab Objectives:
The students should understand:

e The type of Motherboard in their system casing. (i.e. AT or ATx technology)
e Various components of a board.
e The functions of some of these components

1. Observe the motherboard very well. Draw The board and label the following:
i. PCI Slots. How many are they and what is/are their colors?
ii. BIOS
iii. Processor and Processor Heat Sync.
iv. RAM Slots
v. Primary & Secondary IDE Slots
vi. What type of GRAPHIC ADAPTER is in your system? (is it VGA or SVGA)

Check sheet for Motherboard components

Component Make (if any) Pins(if any)

Bios

Processor

Motherboard

PCI Slots

Phone Jack

RAM

Lab Exercise 3: Understanding the Functions of Computer Kevyboard

Instruction:

e You should write your answers to the questions below in your notebook.
e You must give your notebook to the lab instructor for marking.



Lab Objectives:
The students should understand:

1.
2.
3.

The type functions of the keyboard buttons
How to position fingers ergonomically.
How to combine some buttons as Shortcuts

Observe the Keyboard, locate and know the functions of these buttons:

1. The Function buttons

ii. Computer Special Keys (Enter key, tab, Shift, backspace, ctrl, alt and CapsLock
iii. Prt Sc (print screen), Space bar

iv. What is the function of F1, F8, F10 and F12.

v. Num Lock, Windows Logo button, Esc button.



Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 02: Operating Systems 1

Lab Exercise 1:

Requirement: the lab exercises requires Windows 8
— Change the size of Icons on the desktop

a. Right click on the free space of your DESKTOP

b. Point to VIEW option and choose either Small, Medium or Large icon size. Toggle between them and
see how they differ.

— Sort Icons
a. Right Click on the free space of your DESKTOP
b. Point to SORT BY and Click NAME option. Then

c. Repeat item b., but this time click on ITEM TYPE option.

— Add / change wall papers

a. Right-click your desktop and choose Personalize. The following window appear:



+ Control Panel ¢ Appearance and Personalization » Personalization

Jome .
Change the visuals and sounds on your computer
picons Click a therme to change the desktop background, coler, sounds, and screen saver all at cnce.
: painters My Themes (1)
‘ ‘j H
-
Unsaved Theme
Windows Default Themes (3}
waoow b
[ =S4 |
Windows Lines and colors Flowers
High Contrast Themes (4)
'y
3 : [ = =]
wigation

Desktop Background Color

Select Desktop Background from the windows’ bottom left.

Click a new picture for the background. You can click the drop-down list to see all the available
photos and colors that Windows offers



Choose your desktop background

Click a picture te make it your desktop background, or select more than ene picture to create a slide show.
1 - I 1
v | Browse.. | | Selectall | | Clearall |

Picture location: iWindows Desktop Backgrounds

4 Flowers (6)

4 |ines and colors (7)

4 Windows (1)

Picture position: Change picture every:

30 minutes
Center v

Click on fill, fit, stretch, tile, or center to position the picture in different format.

Shuffle

c.

f. Click the Save Changes button to save your new background.

— Change screen saver

Method 1: Set/change screen saver in Appearance and Personalization settings.

a. Right click on WINDOWS LOGO KEY and select CONTROL PANEL
b. Choose APPEARANCE AND PERSONALIZATION in Control Panel.



1+ B8 » Control Panel » v

Adjust your computer's settings

View by: Category *

v,

N v

-

System and . User Accounts and
Security Family Safety
Review your computer's @ Change account type
status #) Set up Family Safety

Save backup copies of
your files with File History

for any user

Find and fix problems _. Appearance and

%’ Personalization
Network and Change the theme
Internet Change desktop
View network status and background

c. In Appearance and Personalization window, click Change screen saver under Personalization.

®.-

Control Panel Home

Systerm and Security

Metwork and Internet

Hardware and Sound

Programs

User Accounts and Family

Safety
* Appearance and

Personalization

Clock, Language, an

1+ W » Cont.. » Appearance.. » v ¢

Personalization
Change the theme
Change desktop background

=

Search Control Panel

Change sound effects

Display
Make text and other items larger or smaller
Adjust screen resolution

Taskbar
: Bl Customize icons on the taskbar
d Region

—_N —_ roa —_

¥

Change the celor of your taskbar and window borde
| Change screen saver |

d. On the Screen Saver Settings window click the down arrow under Screen saver and choose
option 3D text.



Screen Sawver

Screen saver

Photos w Settings... | | Preview
[TMone]
30 Text me, display logen screen

BElank
Bubbles

Photos nce by adjusting display
Ribbons
Change power settings

e. Click on the SETTINGS button

Text
() Time Low High
(@) Customn Text: |er1dow53.'| O
: Display Settings
Size =
rge
| Choose Font Small
Meotion
Rotation Speed
Slow Fast
Rotation Type: Spin v m

f.  Under CUSTOM TEXT option, delete whatever is in there and type “WELCOME TO
AHMADU BELLO UNIVERSITY”.
g. Click on OK

Method 2: Set/change screen saver in Personalization settings.

a. Right click any blank area on the desktop and select Personalize to open it.



View
Sort by
Refresh

Paste
Paste shortcut

MNew

BS  Screen resolution

Personalize

b. In the Personalization window, find and click Screen Saver on the bottom right corner.
c. Continue from step d. in the previous method.

@ v ¢+ B Appe... » Personalization v & Search Control Panel

Control Panel Home

NS

Change desktop icons

Change mouse pointers i 3
High Contrast 1 High Contrast #2

High Contrast Black High Contrast White

See also . & J’Jj @ I
Display L . @

Background 4\ tomatic Windows MNone

Ease of Access Center Harmony Default




— Change Mouse Pointer size and color via Control Panel
a. Right click on Windows button and Select Control Panel

b. In the Control Panel Window select Ease of Access

+ » Control Panel » v & ] o
Adjust your computer's settings Viewby: Category ¥
T save backup copies of your - % Cha;ge accn:m't type (e

files with File History

Set up Family Safety f
Find and fix problems ﬂ W U

UsEer

_ Network and Internet . Appearance and
tﬂ‘ Connect to the Internet Personalization
=&, View network status and tasks

N Do Al Change the theme
sharing options Change desktop background

Adjust screen resolution

Hardware and Sound | d
5 g View devices and printers C O-Ck. Language' an
Add a device M Region
.

Add a language

Programs Change input methods
s Uninstall a program Change date, time, or number

formats

@ | Ease of Access
- Let Windows suaaest settinas

c. Inthe Ease of Access window, choose Change how your mouse works

@ @ - t 9 ¢ Control P... » Ease of Access » v Search Control Panel 2

Control Panel Home
Ease of Access Center

Let Windows suggest settings | Optimize visual display

em and Securi
ot = Replace sounds with visual cues
Metwork and Internet | Change how your mouse works |
Hardware and Sound Change how your keyboard works
Programs [8] Speech Recognition

d. In the next window, choose the mouse pointer you like from the list of mouse pointers,
and then click OK to exit the interface,



@ * T @ « Ease.. » Makethe mouse easi... v & Search Control Panel el
(4l
Make the mouse easier to use
When you select these tools, they will automnatically start each time you sign in.
Mouse pointers
Change the color and size of mouse pointers,
(®) Regular () Regular Black & () Regular [H
White % I I Inverting
(") Large White % I i) Large Black I ) Large H
k Inverting
() Extra Large ]: () Extra Large I () Extra Large
White Black Inverting
Control the mouse with the keyboard
[] Tum on Mouse Keys
Lise the numeric keypad to move the mouse around the screen. -

OK Cancel | |

Apply |

— Change Mouse Pointer size and color via Mouse Properties.
a. Follow steps (a to d) in the previous method

@ * T 9 <« Ease.. + Make the mouse easi... v & Search Control Panel
| wine L Black L inverting  *y A

Control the mouse with the keyboard

[[] Turn en Mouse Keys

Use the numeric keypad to move the mouse areund the screen.

Set up Mouse Keys

Make it easier to manage windows

[[] Activate a windew by hovering over it with the mouse

[[] Prevent windows from being automatically arranged when moved to the edge of the screen

Se
Mouse settings

Learn about additional assistive technologies online

12



b. In the window of Make the mouse easier to use, move the scroll bar down and select Mouse
Settings
¢. In the Mouse Properties dialog box, choose Pointers on the top, Click on the down

arrow under Scheme, select a pointer scheme in the pull-down list and click OK to affirm the
changes.

|Windows Inverted (system scheme)
y Windows Standaml {extra large) (system scheme)

— Change Power Button Action with Control Panel

a. Click Window + X keys on your keyboard
b. Select control panel

13



Programs and Features
Power Options

Ewvent Viewer

System

Dewvice Manager
Metwork Connections
Disk Management
Computer Management
Command Prompt

Command Prompt (Admin)

Task Manager

Control Panel

File Explorer
Search

Run

Shut down or sign out

Desktop

c. Click on hardware and sound
d. Click on power options
€. On the left, click on what the power buttons do

i@ Power Options - [ | b4

— L a » Control Panel » System and Security > Power Options w0 Search Control Pane| =

Control Panel Home .
Choose or customize a power plan

Choose what the power A power plan is a collection of hardware and systern settings [lilke desplay brightness, sleep, etc.) that
Buttens o manages how your computer uses powes. Tell me maore sbout power plans
Create a power plan Prefesred plans

B Choosewhen to tum off the (@) Balanced [recommended) Change plan settings

display S =

f. In the drop down list When I press the power button, select the desired action.

& > A 31: Hardware and Sound » Power Options » Systemn Settings w Search Control Pane ¥

File Edit Wiew Tools Help

Define power buttons and turn on password protection

Choose the pewer settings that you want for your computer. The changes you make bo the settings on this
page apphy to sl of your power plans.

9 Change settings that are currently unavailzble

Power and sleep button settings

@ When | press the power bautbon: Shut down L

Do nothin
e When | press the dleep button: Tum off the display

— Adding Run Command to Start Window/Menu using Pin to Start.

a. Click on Start Menu or press Window Key on your keyboard



b. Type run

A p pS Results for “run”

Run v

c. The Run command appears as the list of items that begins with “run”
d. Right click on Run and select pin to start

Unpin from Start
Pin to Taskbar
Open in new window

Open file location

The Run command will be added to your start menu or window

— Remove Run Command from Start Window/Menu

a. Click on Start Menu or press Window Key on your keyboard

b. If Run command is not visible, use the horizontal scroll bar to scroll to the right to
look for it

c. Right click on Run

Unpin from Start

Pin to taskbar
Open new window
Open file location

Resize

15



e. Select Unpin from start
The command will be removed from the start screen

— Add and Remove programs from Taskbar (pin and unpin Apps on taskbar)

MNew folder

c .

— Pin Calculator on taskbar

a. Click on start or press Window key on your keyboard
b. Type calculator, this could bring the result below:

Search

Everywhere -

calculator ﬂ

16



c. Right click on calculator and select Pin to taskbar

Everywhere

calculator E

Pin to Start
Pin to Taskbar
Open in new window |

PHFP Tutorial .

Run as administrator
aunt

Open file location

The calculator is added as shown below:

|[Elea &

90 (————

o ] 3
a7y R P

3/29/3

— Remove or Unpin a program from TaskBar

Unpin the Calculator from the taskbar
a. Right-click on the calculator in the taskbar
b. Select Unpin this program from taskbar

G Calculator
o Unpin this program from taskbar

17



Ahmadu Bello University, Zaria
Department of Computer Science

COSC101: Introduction to Computing

Laboratory for Week 03: Operating Systems2

Exercise 1:

e o o P

Locate a free space at the DESKTOP of your system

Create a folder called COSC 101

Double click on the COSC 101 folders to open it.

Create Five more folders called COMPUTER FUNDAMENTALS, MS WORD, MS EXCEL,
POWERPOINT and INTERNET RESPECTIVELY.

Create two additional folders called LEC and LAB for lecture and Laboratory respectively.
Click and Drag LEC into COMPUTER FUNDAMENTALS Folder, drag LAB also into that
folder

Repeat the same procedure in items e & f but this time drag those folders into MS WORD, MS
EXCEL and POWERPOINT folders.

Double click INTERNET folder to open it

Create the LEC and LAB in the INTERNET folder as depicted in the diagram below

Coscl101
|
[ | 1 : :
Computer MS Word MS Excel PowerPoint Internet
Fundamentals
—  LEC —| LEC |[H LEC — LEC -1 LEC
| a8 < w8 |4 e |4 e | H L8

18



Exercise 2: Setting date & time

/e o o P

-

Click the START button
Click on CONTROL PANEL

Locate and Click on “CLOCK, LANGUAGE AND REGION” option

Locate and double Click on DATE AND TIME. A dialog box like

will appear.

Date and Time | Additional Clocks | Internet Tme |

(UTC+01:00) West Central Africa

Daylight Saving Time is not observed by this time zne.

Get more time zone information online
How do I set the clock and time zone?

Date:
Thursday, January 26, 2012

1% Change date and time...

Change time zone...

e.
f.
g.
h.

[

Apply

Click the “CHANGE DATE AND TIME” button

Reset back your DATE to 05/10/11 and your TIME to 10:30pm
Click OK twice to confirm your changes.

View you new date and time at the task bar.

Reset your DATE/TIME back to current date and time.

Exercise 3: The Run Command

The RUN command is accessed in two ways:

1. through the Start menu and

2. through the short cut key Win + R on the key board (i.e. windows Key + R)

Now, use the RUN Command to lunch the following applications:

a0 o ow

mspaint (Microsoft Paint)
calc (Calculator)
winword ( Microsoft Word)

powerpnt (PowerPoint)

the figure below

19



Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 04: Text and Paragraph Formatting

Laboratory Objectives

The aims of this laboratory practical is to ensure students are able to create an MS word document, type
in text and apply fext and paragraph formatting.

Instructions

1.

W

You will create an MS Word file named YourRegNo-cosc101-Lab01.doc, where you will
replace YourRegNo with your university Registration Number. For example, if your
Registration Number is U20CS1089, the file name will be U20CS1089-cosc101-Lab01.doc.

You will follow the steps outlined below and perform the exercise and save in the file created in
Step 1.

You will create a directory LabMSWord and save the file in Step 1 inside this directory.

Keep repeating the save operation after few minutes to avoid losing data in case of an abrupt
power failure

You will submit your completed exercises to your Lab instructor before you leave the lab class.
Your instructor will advise you how to submit completed exercises.

Hands-on Guide

Task 1

1.

2.

On the Document window, type the text below as it is .

Introduction to Microsoft word

On the Insert tab, the galleries include items that are designed to coordinate with the
overall look of your document. You can use these galleries to insert tables, headers,
footers, lists, cover pages, and other document building blocks. When you create pictures,
charts, or diagrams, they also coordinate with your current document look.

You can easily change the formatting of selected text in the document text by choosing a
look for the selected text from the Quick Styles gallery on the Home tab. You can also
format text directly by using the other controls on the Home tab. Most controls offer a
choice of using the look from the current theme or using a format that you specify
directly.

Triple click on the topic sentence of your document to select it

20



10.

11.

12.
13.

14.

15.

16.

. On the Font Group of the Home Ribbon Click

the B icon to make the topic sentence bold

QEs 0drs
Click the drop down arrow beside the number i“ AL (AR INERRNL o
. . (= N 0 m w w
11. Numbers will appear vertically arranged, | f’fc“' Gl fi1 A& e
=3 Copy
select 18. Pttty ® 1 U X A% |
Clipbowd n Foel [

. Click the drop down arrow on the left hand

side of the writing ‘Calibri’, a list of font styles
will appear, select Georgia to apply.

. Click on the drop down arrow on the left hand side of the icon that carries the symbol A with a

thick red line under, a list of colours will appear, select the blue colour on which is the fourth in
the first row of the colour palette displayed.

Click on the dropdown arrow besides the icon that carries the symbol Aa, select UPPER CASE to
make the topic sentence appear in capital letters.

On the first paragraph of the text hold down CTRL key on your keyboard and click on the second
sentence to select it.

On the Font Group of the Home Ribbon Click on the symbol of 7 to italicise the selected text.

A description of what an icon does flips up immediately you put your mouse pointer on it. Move
the mouse pointer over the icons of the Font group. Click on the drop down Arrow besides the
icon that shows the description, ‘Text hightlight Colour’. Colour palette will be displayed, select
red colour to apply on the selected text.

Again select the topic sentence of your document. Move to St
Paragraph Group next to the Font Group and run your mouse ~"C5>  MAILINGS  REVIEW  WIE
over the icons. Click on the icon that shows the description,
Center (Ctrl + E). The topic sentence will be centralised on
your document page. Alternatively after selecting the topic Paragraph =
sentence you can press CTRL key, hold it down and press the

letter E, to achieve the same effect.

e~ &= 3=

N

)

{ T

I
it
[42

Place your cursor before the first letter of your first paragraph.

Hold down SHIFT key on your Keyboard and press the DOWN ARROW key to select the text
till the end of the second paragraph.

Move to Paragraph Group next to the Font Group and move the mouse pointer over the icons
until the icon description shows Line Spacing. Select 2.0 to have double lines space on your
document text.

Triple click on the first paragraph to select it and move the mouse pointer over the icons until the
icon description shows Align Text Right (Ctrl + R). The paragraph will be aligned right on your
document page. Alternatively after selecting the paragraph you can press CTRL key, hold it down
and press R on the key board.

Triple click on the second paragraph to select it and move the mouse pointer over the icon
description shows Align Text Left (Ctrl + L). The paragraph will be aligned left on your
document page. Alternatively after selecting the paragraph you can press CTRL key, hold it down
and press L on the key board.

21



17. Go back to select the first paragraph and do as in step 10 until the icon description indicates
anything border, then click on the drop down menu besides the icon and select outside borders.

The paragraph will be en-squared in a border.

18. When you are done your document will look like this:

INTRODUCTION TO MICROSOFT WORD

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of

vour document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and
_ When you create pictures, charts, or diagrams, they also coordinate

with your current document look.

You can easily change the formatting of selected text in the document text by choosing a look for the

selected text from the Quick Styles gallery on the Home tab. You can also format text directly by

using the other controls on the Home tab. Most controls offer a choice of using the look from the

current theme or using a format that you specify directly.

Task 2:
1. Type the following text as it is:

Components of Microsoft window
Ribbons

Title Bar

Document area

Task bar

Status Bar

Types of Computer

Mini Computer

Mainframe Computer

Personal Computer

All *
Current List
1
o
List Library
1]
Maone a)
il
& Apticle |. Headi
* Section 1.01 |
L] (&) Heading 2
|. Heading 1 Chapter 1 Hez
A Heading & Heading 2

1. Headin Haading 3

<> | Change List Level
Define Mew Multilevel List...
Define Mew List Style...

1 Heading 1
1.1 Heading 2

1.1.1 Heading :
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Select the first bolded item Component of Microsoft window. While that is still highlighted
move to the second item and place your cursor at the beginning of the line. Hold down CTRL key
and select the second . The two items will be both highlighted.

Move to Paragraph Group next to the Font Group and do as in step 10 in the previous exercise
until the icon description shows Multilevel List. Click on the drop down arrow attached to the
icon a menu will appear as shown in the corresponding image.

Click on the second item under list library. The bolded items will appear in a list of 1 and 2.
Select the next items after Component of Microsoft window.

Do as in step 3 above and when the menu appears click on the current list. All the 5 items will be
numbered but not on the same level with the other two items.

Do as in step 6 above for the items under Types of computer

Your output should look like this:

1) Components of Microsoft window

1.
2.

4.

5

Ribbons

Title Bar
Document area
Task bar
Status Bar

2) Types of Computer

1.
2.
3.

Mini Computer
Mainframe Computer
Personal Computer

Task 3: Take Home Assignment

1. Create a document of your own and save it in the format above but add take
home in the document name.

2. Type a three paragraphed text and apply text formatting from Font Group from
the icons that this lab covered and those it did not cover.

3. Similarly study the Paragraph Formatting Group and do the same to your
created document.

. Create a MultiLevel List of items up to 5 levels
5. Submit before the next lab.

23



Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 05: Tables and Graphics

Laboratory Objectives
The aims of this laboratory practical are to ensure students are able to create tables and insert graphics
in an MS word document.

Instructions

1.

(98]

Open the document you’ve created in your last week’s lab and save it afresh with this format
YourRegNo-cosc101-Lab02.doc with reference to the instructions given earlier. Note the change
on Lab01 to Lab02.

You will follow the steps outlined below and perform the exercise and save in the file created in
Step 1.

You will save in the same directory LabMSWord you’ve created earlier.

Keep repeating the save operation after few minutes to avoid losing data in case of an abrupt
power failure

You will submit your completed exercises to your Lab instructor before you leave the lab class.
Your instructor will advise you how to submit completed exercises.

Task 1: Create and format Table

1.

. Align the text of each column to the centre. :

Insert a table after your last week’s take home exercise. Locate the insert tab on the menu bar
and click it. The Insert Ribbon will appear:

Click the Table Group and select from the drop down
menu an 8 rows by 4 columns table Enter the
following labels (column headings) into the first row

Design  Layout  References

of the table: Cover Blank Page Table onine Sh{ms}_;‘m_ﬁ‘.(
NAMES STATE AGE DATE OF = 07 e
BIRTH .

Enter text to correspond to the column headings.

Bold the title in each column of the table and use 12
font sizes. ;
Make the background of the first row Dark blue. : B imsert Tae

The final table should look like this: . ek Dbl :

24



Abacha Kano 105 12-03-1935
Obasanjo Osun 15 02-05-1995
Yar’dua Katsina 20 06-09-1990
Goodluck Bayelsa 87 01-01-1993
Babangida Niger 25 15-05-1890
Bubhari Katsina 10 05-10-1940
Murtala Kano 5 02-05-1840

Task 2: Insert Graphics

1. Go to the next blank page in your document and place your cursor on the Editing window.

Click the Insert tab.

3. Click the Shapes button. Choose a shape (e.g. a box) and insert it in the Editing window. Stretch
out the shape to the size you desire. Drawing Tools will appear (above the Format tab on the

Ribbon) when you finish drawing your shape. Using the drawing tools, you can format your
shape and design it nicely.

N

H&0: Document2 - Word (Product Activation Failed)

file  Home Inset Design layout References Mailings Review View NitroPro

L 0 < Edit Shape - + 32 Shape Fill - A TextF Text Direction L Uy Bring Foward - [ Align~ ¢ "
EANADOO tla3tem
ALL & - EldawTexBox || Ae u « L7 Shape Qutline ~ Text Outline - [3]Align Text - £1Send Backward * = -

Group
T s § Position Wra i — “
(RUSES % & Shape Effects A\ TextEffects~ & Create Link Te xtE B SelectionPane. “ARotate~ &+ M46T(M
Insert Shapes Shape Styles 11 WordArt Styles Text Arrange Size N
1 \‘2‘\‘1‘\‘5‘\-1‘\‘2‘\‘3‘\‘4‘\-5‘\‘6‘\‘7‘\‘9‘\-9‘\‘10‘\‘11-\‘12‘\-13‘\‘14‘\‘15-\‘16‘\‘17‘\‘18‘\‘19-\‘20‘\‘21‘\‘ZZ‘\‘23-\‘24‘\0‘25‘\‘26‘\‘27

4. Right click on the shape and choose ‘Add text’. Type “The recipe to success” in the text box.

g 5

Home Insert Design layout g A\ uabbadews@gmailcom 9. Share|
0=  Edit Shape - N - A Text Fill - A Text Direction~  [23] Bring Forward ~ [Z Align~ o
= = s = = = T flz2em
DrawTextBox | | 4bc || | Abc | | abe | - [Z Shape Outiine - A A - & Text Outiine - - 5] Align Text - = & Send Backward
J ~ 8 Position Wrap . § = =igan ©
* @ Shape Effects - * B\ Text Effects~ | @ Create Link e~ DhSelectionPane  ZhRotatex ses MIcm .
Insert Shapes Shape Sty Wor tyles Text Arrange Sze
L 7\- . A~ gt e S0 R ikl ¢ 9-:l[‘-\L-_\LZIlSiHI-lﬁllﬁ\-l?-l-lJllli\

1
P
)

The Recipe to Success

1

Oo—o0—0

—O0—0
IRl

5. Now, create four more boxes (containing the word: Self Motivations, Positive Attitude,
Hardworking, and Perseverance). To make the outline of the box disappear, right click the text
box, select Format Shape. Under the Shape Options Tab, Collapse Line, choose No Line
option.
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Format Shape MR
Shape Options Text Options

<> 7 1

L Fill
4 Line
(® Mo line
) Solid line |

) Gradient line

Yours should look like this:

6. Now, from the Drawing tools, click on the Format, Insert Shape-> Block Arrows and choose
your desired arrow style.
7. Place the arrow (vertically) between the first and the second box.

insert  Design  Layout R M: Nitro Pro Sha
e o = a: o PFind -
Calibri Body;- |11 ~| & A Aa~ | fp : €352 2 T |nssocend| mabeedd AgBbC( AaBbCch /—\aB ASBOCCD AcBBCCDd AGBbCcDd  AcBHCcDJ ASBBCEDE AGBBCCDY g oo
— B2 Copy kY
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8. Repeat the steps until you have the following diagram (tips: you could just copy and paste the

arrow):

Task 3: Group the Objects
9. One of the concern issues is that if you want to position or reposition the diagram, you need to
move each of the objects one by one, which could be quite time consuming. What you can do is

to group all the objects in the diagram. In order to do this, hold the SHIFT key and click on each

of the objects.

et Caiibri Bogy-[1 <[ & K (Aav B i SR 8T | asebcend| AaBbeedd AaBbC( AaBbCcl A D aabbeed acBbredd AoBbCeDd AaBbeeDd AaBbeeDe AaBbecDd

Paste. & |- -
2" fomatpointer | B 7 U cemxx [ B-F- 4

Clipboard

DR L 2o 3 041 -5-1 6 1-7-1 8.1

Styles
OIS U RO PIIRE * NIRE - T o

e The Recipe to Success

Iy

Self Motivation

Positive Attitude

Hardworking

Perseverance

vagetoft tomerds [

TNormal | TNoSpac.. Heading1 Heading2  Title Subtitie  Subtle Em.. Emphasis Intense E Strong Quote

%, Replace

= [} Select~

5 Eding -
W,

I ® - 1 + 100%

11. Once you are done, point your cursor to the selection until a cross symbol appear. Right click.
From the pull down menu, choose Grouping -> Group. (You could ungroup or regroup using the

similar steps).

Fill

Outline

Cut

Copy
Paste Options:

Y

O

id] Group

Bring to Front
Send to Back

Insert Caption...

i Wrap Text

More Layout Options...

Format Object...

13

[ Group

I
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12. Now if you move one object, the rest of the objects will follow

Task 4: Insert Header and Footer and Page Number

13. Go to Header and Footer on the Insert Ribbon. Select the header and click on first option and
type your Matric Number. Click on the footer area on the same page and type your full name.

14. Go to Page Number on the Header and Footer group of the Insert ribbon, click on bottom
page number and select the first option.
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Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 06: Table of Contents, References and Citations, Mail Merge

Laboratory Objectives

The aims of this laboratory practical are to ensure students are able to use a given document to create
Table of Contents, generate table of references and citations and also experiment with Mail Merge.
Instructions
1. Download from the link www.abu.edu.ng/iacc the required document for this lab and save it as
YourRegNo-cosc101-Lab05.doc with reference to the instructions given earlier. Note the change
on Lab01 to Lab05.
2. You will follow the steps outlined below and perform the exercise and save in the file created in
Step 1.
3. Youwill save in the same directory LabMSWord you’ve created earlier.
4. Keep repeating the save operation after few minutes to avoid losing data in case of an abrupt
power failure
5. You will submit your completed exercises to your Lab instructor before you leave the lab class.
Your instructor will advise you how to submit completed exercises.

Task 1: Create Table of Contents

The easiest way to create a table of contents is to use the built-in heading styles. You can create a table
of contents that is based on the custom styles that you will add to your document. For example you
might only want a Heading 1 in your Table of Contents, or both Heading 1 and Heading 2.

Step1: Mark Entries By Using Built-In Styles or Modify Styles

If your document is already created then select the words to which you want to apply a heading style
to, which when the Table of Contents is added will list as the first indent or Heading 1 as shown
below. If it is a brand new document you are building then each time before you start typing choose
Heading]l style for it to appear in your Table of Contents.

Built-In
Automatic Table 1

Conlents
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Select the text, then on the Home tab, in the Styles group, click the Heading 1 style. This will change
that text to be a style for the Table of Contents.

|fIaBEJCc;I AaBbCi
[ Emphasis Heading 1 T Marmal Strong Subtitle

Change
Styles =
Styles P}

AaBbCcl AaBhCcl AaBbCe. ’j %
|

If the style for Heading 1 does not have the correct font, size and color you can change it by right
mouse clicking and choose Modify in the Styles gallery.

AaBbCcl | AaBhCcl | AaBbCcl AaBbCel 4aBbCd

Emphasis Headi 1 Strama Corktitla
= Update Heading 1 to Match Selection

Modify...

|

' 3 ' ' ' ' '
. f Select All 2 Instance(s)
e ot e 1 R

Rename..

Remove from Quick Style Gallery

Add Gallery to Quick Access Toolbar

Under Name, you can change it or leave as Heading 1. The Formatting area is where you will
change the Font type, size and color. Notice at the very bottom you can choose Only in this
document or New documents based on this template. Click OK when finished. Your Heading 1
style will now be changed on the Styles Gallery.

Properties
Name: |Heading L |
Style type: |Linked {paragraph and character) |z|
Style based on: | T Normal E
Style for following paragraph: | T Normal E
Formatting
Frestiwianen [F] 2 (]| (B) £ 1 | duere 5]
= = = o — = = i= =
= == = | % — —; | = = ‘:'_.'— 2_.'—
| F
Font: Bold, Space
Before: 24 pt, Keep with next, Keep lines together, Level 1, Style: Linked, Quick Style
Based an: Normal
Following style: Normal
Add to Quick Style list [ Automatically update
@) Only in this document (&) New documents based on this template
o [Com )
—

If you know you want to use Heading 2, then Modify that style to reflect the Formatting



you want. Click OK.

Step 2: Now Create A Table Of Contents

Now that your document has styles added to specific entries for your table of contents you are
ready to add a Table of Contents.

Click where you want to insert the table of contents, at the beginning of a document. If you need to
add a blank page at the beginning, click on Insert tab, Blank Page. Have your cursor sitting at the
place you want to table to be.

On the References tab, in the Table of Contents group, click Table of Contents, and then click on
the table of Contents style that you want which will insert it.

Home Insert Page Layout References
Add Text ~ AR [y Insert Endnote
[ update Table Ag Mext Footnote -
Table of Insert

Contents = Footnote ﬁ Show Motes
Table of Contents | Footnotes fa

Table of
Contents |

Built-In
Automatic Table 1

Conlents
Heading 2......... ——
T CMEREE 0 om0 i s K i1 51

A Table of Contents will now appear as shown below.

Contents

Mark Entries By Using Built-In Styles or Modify Styles. ..o 2
Now Create A Fable O BORTENES. ... ..o s s st ssmsssmssss s s e 4
Mpdate e b e O i S, e i 5
el et E A B S O I 5 e 5

Update a Table of Contents

If you already have a table of contents in your document, but now you have edited the text by either
adding or taking away text, which will make a change in your page numbers in your Table of
Content change, then you will need to update the table of contents. Hold your mouse over the Table
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of Contents and it will appear blue as shown below. Just click someone in that area to select the

Table of Contents.

Contents

Mark Entries By Using Built-In Styles or Modify Styles

Now Create A Table Of Contents. ..o
EipdatesThesTable ) G it i - ——
T el et AT a bl 2 O L oM T

On the References tab, in the Table of Contents group, click Update Table.

[Ep 2dd Text -
21 Update Table
Table of
Contents =

Table of Contents

Click Update page numbers only or Update entire table. Click OK.

Update Table of Contents l P s )

Word is updating the table of contents. Select one of
the following options:

(7 Update page numbers only

You can also click on the Update from within the table on the document as shown below. To the left of
Update it a drop down arrow that allows you to change they type of Table

of

HIE -]g@ UpdateTable...I

Built-In
Automatic Table 1

=~

'LI Heading 2 ...
™ Heading 3
LY
L

Auvtomatic Table 1

| Conlents

Heading 2 ....
Heading 3

Auwvntomatic Table 2

Table of Contenis

Meading 2 ...
Heading 3

Automatic Table 2

Table of Contenis

Heading ...
Heading 3

Remove Table of Contents

A L o o L S s

B L e e O L R i Sy

BT TR 1 i i A 3 S

Contents.
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Delete a Table of Contents

On the References tab, in the Table of Contents group, click Table of Contents.

Maore Table of Contents from Office.com
Insert Table of Contents..,

Bemove Table of Contents

Click Remove Table of Contents. You can also Remove Table of Contents on the
Update drop down as shown on screen shot above.

Task 2: Inserting a Reference

To insert a reference (a citation) in your text:

1. Start by typing some text (anything will do)

2. Move to the REFERENCES tab on the Ribbon and note the Citations and Bibliography group:

3. Click on [Insert Citation] and choose Add New Source... - the Create Source dialog box

appears:

rCreate Source | 9 —BE-J
Type of Source ‘z| lLanguage |Default |Z|
Bibliography Fields for APA
Author T
[7] corporate Author
Title
Year
City
Publisher
[ show Al Bibliography Fields
Tag name
Placeholderl ‘I] ﬂ
y

4. Using the list arrow provided set the Type of Source to whatever is required — here keep it as

Book

5. Fillin the Bibliography Field for APA (use the example provided here or add your own reference):

[

I O R I A O

Author: Mickey Mouse (press <Tab> three times)
Title: A History of Cartoons (press <Tab>)
Year: 2010 (press <Tab>)
City: Hollywood (press <Tab>)
Publisher: Disney Press
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6. Press <Enter> for [OK] when you have completed the entry — your reference appears in the

text as (Mouse, 2010)

For some references, you may need to record additional fields. This next example shows you how:

7. Repeat steps 1 to 4 again, as above

8. Now turn on Show All Bibliography Fields - note what’s available

9. Fillin the Bibliography Fields as below (or use one of your own references):
[0 Author: Click on Corporate Author and type British Broadcasting Corporation
[0 Title: Cartoon Classics

Year: 2000

City: London

Publisher: BBC Publications

Pages: 1-34

[J Edition: 2nd Edition

O o o O

10. Press <Enter> for [OK] — your reference appears in the text as (British Broadcasting Corporation,
2000)
By using a Corporate Author, spaces in the author’s name are ignored and the author appears in full.
Ifyou have a real author with a space in their surname (eg Paul St John), you must use a non-
breaking space for the space. This special character can be typed using <Ctrl Shift spacebar>.
11. Repeat steps 1 to 4 again but change the Type of Source to a Journal Article
12. Fill in the following Bibliography Fields as below (or use one of your own references):
[0 Author: Mouse, Mickey; Duck, Donald (use a semi-colon to separate more than one
author and note that you should enter names in the format surname, first name)
Title: Drawing Cartoon Characters
Journal Name: Cartoon Journal
Year: 1996
[J Pages: 132-147
13. Turn on Show All Bibliography Fields and add
[0  Volume: 23

O 0o O

14. Press <Enter> for [OK] — your reference appears as (Mouse & Duck, Drawing Cartoon Characters,
1996)
Normally, you wouldn’t include the Title but this particular referencing style does. You’ll see how to

change
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this later. Try adding one further reference:

15. Repeat steps 1 to 4 again but change the Type of Source to a Web site

16. Fill in the following Bibliography Fields as below (or use one of your own references):
0 Name of Web Site: Mickey Mouse — The Official Site
[0 URL: http://disney.go.com/mickey

Using a Placeholder

If you want to add a reference but do not have the full details with you, you can add it as a
placeholder. You can then subsequently edit this with the details (you’ll be doing this later). To
create a placeholder:

1. First, type in some more text

2. Click on [Insert Citation] and choose Add New Placeholder... - a Placeholder Name dialog box
appears

3. Typein a meaningful name (spaces and periods are not allowed) —eg DDuck

4. Press <Enter> for [OK] to close Placeholder Name — your reference appears as (DDuck)

Managing Sources

The [Manage Sources] button in the Citations & Bibliography group allows you to edit and delete
references from your master list. Another facility lets you add a new reference without including it
as a citation. You can also copy references into a document from another master list:

1. On the REFERENCES tab, click on [Manage Sources] —the Manage Sources dialog box appears:

Source Manager [ 9 [
Search: Sart by Authar |

Browse...
Current List
British B Z" g C £ it
M k yM ~The O
MkyAlenyrl ns (2010}
e, Mickey, Duck, Donald; Drawing Cartoon Characters (1996)

DD

7 Brah Broadca lng t n; Cartton Classics (2000)
¥ Mi kyM =t

v M
¥ Mo

uuuuu 'AH
M ckey, Du Kn m Drawin ng Cartoon Characters (1996)

v cited source
2 placeholder source

Preview (APA):
Citation: (British Broadcasting Corporation, 2000} -

Bibliography Entry:
British Broadcasting Corporation. (2000). Cartton Classics (2nd Edition ed.). London: BBC Publications.

Close
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Note that you have a Current List of the references in the document you are working on
and a Master List of all your references. References which have already been cited in the
text have a tick against them; the placeholder is shown with a question mark against it.
It’s now time to turn the placeholder into a reference:
2. Select the placeholder reference (DDuck) and [Edit...] it
3. Ifnecessary, change Type of Sourceto Web site
4. Type in the following Fields:

0 Name of Web Page: Donald Duck

0 Name of Web Site: Wikipedia

[0 URL: http://en.wikipedia.org/wiki/Donald Duck
5. Press <Enter> for [OK]

Currently, your new reference is only held in this document. To store it in your master
list:
6. With the reference still highlighted, click on [<- Copy] to move it into the Master List
You can also add new references here:
7. Click on the [New...] button - the Create Source dialog box appears, as before
8. Change Type of Source to Conference Proceedings
9. Add the following Fields:
[J Author: Walt Disney
[0 Title: The Early Days
Pages: 2-19
Year: 1970

O O O

Conference Publication Name: Third Disney World Conference

[J  Publisher: Disney Press
10. Press <Enter> for [OK] to add the reference to your current and master list
Toremove areference from the current document:
11. Select the new reference and [Delete] it from the Current List—don’t worry, it’s still
in your Master List
12. Reinstate it by selecting it in the Master List and [Copy ->] it back

13. Finally, [Close] the Source Manager — you could also press <Ese>
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Inserting a Bibliography

1. Check that you are at the end of your text then press <Enter> for a new line
2. Click on the [Bibliography] button in the Citations & Bibliography group

You can now choose from three built-in formats (Bibliography, References or Works
Cited) or you can just insert the list of references using Insert Bibliography. Here,
use the first built-in format:

3. Choose Bibliography —the references are listed with a heading of Bibliography

Note that all the references in the current listare shown (not justthe ones cited —
Disney is unticked). To remove the Disney reference (and then update the
bibliography):

4. Click on [Manage Sources], select the Disney reference in the Current List and
[Delete] it

5. Press <Esc> to [Close] the Source Manager

6. Click on the bibliography —it is surrounded by a blue box with two buttons on the
top

7. Click on the second button [Update Citations and Bibliography] and Disney is

removed from the list

The first button (|Bibliographies]) lets you change the heading to References or Works
Cited.

You don’t have to use a built-in format. Try creating your own instead:

1. Drag through the Bibliography and <Delete> it — you may need to press <Delete>
more than once
2. Next, type in your own heading: List of References and press <Enter>

3. Click on the [Bibliography] button and choose Insert Bibliography

A bibliography created this way doesn’t have a blue box and buttons. To update it,
simply right click on the list and choose Update Field.
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Styles

There are several referencing styles built in to Word. So far you have been using the

default style, APA, but this might not give you the results you want. You can easily

choose a different style, which will immediately be reflected both in your

bibliography and the individual references:

1. First, click at the end of your text

2. Now click on the list arrow attached to the [Style:] button in the Citations &

Bibliography group

3. Choose a different style (eg Harvard - perhaps the most commonly-used style) and

note the effect

4. Repeatstep 3 to see what some of the other styles are like (ISO 690 —
Numerical Reference gives you just a number in the text and a numbered list
of references)

5. Endby setting [Style:] back to APA

Sadly, it’s not possible to customise the built-in styles (or, indeed, to create your
own). There is the facility, however, to convert your references and/or bibliography
into editable text. You would only do this if you really needed to (and once you

have finished your document and generated the bibliography).

To convert a reference to text:
6. Click on the Mouse & Duck reference in the main text —the reference is shaded with
a blue box around it

7. Click on the arrow attached to the right of the blue box —a menu appears:

: {Mouse & Duck, Drawing Cartoon Characters, 1996) | :

|

[:'} Edit Citation
Edit Source
LConvert citation to static text

™! Update Citstions and Bibliography

8. Choose Convert citation to static text - note that you can also edit the citation or
source here

9. Remove the title of the paper Drawing Cartoon Characters, (drag through the words
then <Delete> them)
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10. Try changing the [Style:] —the reference in the text doesn’t change, but the
bibliography entry does

11. End by pressing <Ctrls> to [Save] the latest version of your work

Adding References to Another Document

Once you have a Master Source, you can use it to add references to other documents.
Each document has its own set of references, which all appear in the bibliography
(whether cited or not). To see this:

1. Press <Ctrl n> for a [New] document

2. Move to the REFERENCES tab and click on [Manage Sources]

3. Select the references you want in your new document from the master source on
the left

4. Ifyou have alot of references, you may need to use of the Search: box or change

Sort by to Year or Title

Tip: Hold down <Ctrl> and click to select non-adjacent references or use click and
<Shift> click to select a group (just like you can throughout Microsoft —eg to select
emails or files)

5. Click on [Copy ->] to move your references across —make sure you have more than
one

6. Press <Esc> to [Close] the Manage Sources dialog box

7. Now type in some textthen add a reference as before ([Insert Citation] and choose
the one you want)

8. Finally, add the bibliography (click on [Bibliography] and

choose Bibliography) Again, you’ll find that all your references

appear, not just the one cited.

Keeping your Master List

You may wish to keep a copy of your master source file (the reference list in the
document itself is). To copy the master source from its current location into My
Documents and then link to it from there:
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1. Click on [Manage Sources] on the REFERENCES tab

2. [Browse...] for the Source file (which is located in a special Bibliography folder on
drive C:)

3. Rightclick on Sources.xml and choose Copy

4. Now click on Documents on the left

5. Rightclick in Documents library and choose Paste

6

Finally, press <Esc> twice to first [Cancel] then [Close] the Source Manager

You should now have a copy of the file in Documents. Next time you want to add
references to a piece of work, use this file as your source file. In other words:

7. Repeatsteps 1 and 2 as above

8. Next click on Documents

9. Select the file Sources.xml then press <Enter> to [Open] it

10. [Copy ->] the required references to your Current List then [Close] the Source

Manager and continue as before (using [Insert Citation] etc)
Task 3: Mail Merge

Mail Merge is most often used to print or email form letters to multiple recipients. Using
Mail Merge, you can easily customize form letters for individual recipients. Mail merge is

also used to create envelopes or labels in bulk.
This feature works the same in all modern versions of Microsoft Word: 2010, 2013, and
2016.

1. In ablank Microsoft Word document, click on the Mailings tab, and in the Start
Mail Merge group, click Start Mail Merge.

Home Insert Design

=

= .

Envelopes Labels ||Start Mail| Select Edit eti
Merge ~ |Recipients * Recipient List | Merge Fields Elocl ne

Create =start Mail Merge Write i
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2. Click Step-by-Step Mail Merge Wizard.

Start Mail  Select Edit Higt
Merge = Recipients - Recipient List | Merge

&
.-
=
]

=

Letters

E-mail Messages
Envelopes...
Labels...
Directory

Mormal Word Document

3. Select your document type. In this demo we will select Letters. Click Next: Starting
document.

Mail Merge  ~ X

® Letters
E-mail messages

Enwvelopes
Labels
Directory

Send letters to & group of
people, You an personalize
the letter that each person
receives,

Click Mext to continue

Step 1of 6

=¥ Mext: Starting document
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4. Select the starting document. In this demo we will use the current (blank) document.
Select Use the current document and then click Next: Select recipients.

Mail Merge X

Select starting document
How do you want to set up

Use the ourrent dooumée

Start from a template

Start from existing docup

Use the current document

Start from the document
shown here and use the Mail
Merge wizard to add
reciplent information.

Step2of b

# Previous: Select document ty

o Note that selecting Start from existing document (which we are not doing in
this demo) changes the view and gives you the option to choose your
document. After you choose it, the Mail Merge Wizard reverts to Use the

current document.
5. Select recipients. In this demo we will create a new list, so select Type a new list and

then click Create.

Mail Merge i
EQI—cct recipicnts

Use an existing list
o
Selert team Outliook contacts
©
'I@)c-a e list
Type the names and

Gclm.-—.o.l-c |—| recipients
O

O O O O O

o

Ler Tafb
= Mext: Write your letter

= Prewious: Starting dooument
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o Create a list by adding data in the New Address List dialog box and
clicking OK.

-
Mew Address List @g

Type recipient information in the table. To add more entries, click New Entry.

w | Address Line 1 vI

1 | 1] [ p
[ New Entry ] [ Eind... ]
Delete Entry Customize Columns... ' Cancel
[ J | ) ‘
—— |

L

o Save the list.

o Note that now that a list has been created, the Mail Merge Wizard reverts
to Use an existing listand you have the option to edit the recipient list.

Mail Merge ek

Select n:l:.ii icnts

Select from Outlook contacts
Type & new list
Use an existing list

Currently, your recipients are
selected from:

[Office Address List] in "address-l

7] Select a ditferent list..,

Qe rEcpEn

Step 3 of 6
=» Next: Write your letter

& Prewious: Starting doocument
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(¢]

Selecting Edit recipient list opens up the Mail Merge Recipients dialog box,

where you can edit the list and select or unselect records. Click OK to accept

the list as is.

Mail Merge Recipients

=)

This is the list of recipients that will be used in your merge, Use the options below to add to or change your list.
Use the checkboxes to add or remove recipients from the merge. ‘When your list is ready, click OK.
address- list.mdb Jigger Rolling Stomes
address-list.mdb ichards Keith Relling Stones 23 Mag
[4d m | [t
Diata Source Refine recipient list
address-list.mdb - 2] sem.|
T Eitter..
%4 Find duplicates..
. 'E Fi I P .
[ Validate addresses..,
Ref
o

o Click Next: Write your letter.

Mail Merge T
Select recipients

m Use an existing list
Select from Outlook contacts
) Type & new list
Use an existing list

Currently, your recipients are
selected from:

[Office Address List] in "address-|
M1 select a different list...

5+ Edit recipient list...

& Previous: Starting document
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6. Write the letter and add custom fields.

o

Click Address block to add the recipients' addresses at the top of the
document.

Mail Merge  ~ %

Write your letter

If you have not already done
10, wrile your letter now.

Ta add recipient infarmation
to your letter, dick a location
In the document, and then

click ane gf the items below.

] Address block..

& Greeting tine..

j-" Electronic postage...
B More items...

When you have finished
writing your letter, dick Mext,
Then you can prewiew and
personalize sach recipient’s
letter.

Stepdof b
= Mext Preview your letters
€& Prewious: Select recipients

In the Insert Address Block dialog box, check or uncheck boxes and select
options on the left until the address appears the way you want it to.

Insert Address Block =)

Speci Priview
Insert reciplent’ s name in this faormat: Here is a preview from your recipient list:

Joshua = 1 B M
Jashua Randall Jr,

Joshua ©). Randall Jr. [
Mr. Josh Randall Jr.
Mr, Josh Q. Randall Jr.
Mir. lnshusa Bandall Ir,

Lo ompry rone >

— Mick Jagger
Rolling Stones
11 Elm St., Sticky Fimgers, TX 11111

T Neverinclude the country/region in the address
) Aharays indude the country/region in the address

) o Correct Problems
@ Only include the country/region if different than: . . o
If items in your address block are missing or out of order, use
United States Match Fields to identity the correct address elements from

T3] Format ad d e yOuF mailing list.
l“.__-.‘-‘-‘-.fl'l'l__i dress according to the de o m@ Ty

g —
)=
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o Note that you can use Match Fields to correct any problems. Clicking Match
Fields opens up the Match Fields dialog box, in which you can associate the
fields from your list with the fields required by the wizard.

7. Press on your keyboard and click Greeting line... to enter a greeting.

Match Fields D |-

In order to use special features, Mail Merge needs to know
which fields in your recipient list match to the required fields.
Use the drop-down list to select the appropriate recipient list
field for each address field component

Required for Address Block -
Courtesy Title Title [=]
First Mame First Mame E| |
Last Mame Last Mame E| 3
Suffix {not matched) [=]
Company Company Mame E| [
Address 1 Address Line 1 E|
Address 2 Address Line 2 [=]
City City [=]
State State [=]
Postal Code ZIP Code [=]
Country or Region Country or Region E|

-

Optional information

Use the drop-down lists to choose the field from your database
that corresponds to the address information Mail Merge
expects (listed on the left.)

|:| Eemember this matching for this set of data sources on this
computer

] [ Cancel
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MMail Merge =

Wirite your letter

I you hawve mot already dome
20, werite youwr letter moww.

To add recipient inTarmati-on
to your letter, dick a location
im the document, and then
click ane of the items belonw

—% Electronic postage...
El maore items..
Wihemn you hawve Tinished
writimg your lethber, click Mext.
Themn youw can prewiew and
persomnalize each recipient s
lefiter.

Step 4 of 6
= HMext: Prewiew youwr lefters

= Prewvious: Select recipients

In the Insert Greeting Line dialog box, choose the greeting line format by clicking
the drop-down arrows and selecting the options of your choice, and then click OK.
-

-
Insert Greeting Line m

Greeting li

&t |~|  Mr.Randall =] L

reeting line for invalid recipient names:

[]

Here is a preview from your recipient list:

1 [ [

ar Sir or Madam,

Preview

Dear Mick Jagger,

Correct Problems

If items in your greeting line are missing or out of order, use Match Fields
to identify the correct address elements from your mailing list.

Match Fields...
——
[ ! oK ]' Cancel
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9. Note that the address block and greeting line are surrounded by chevrons (« »). Write

a short letter and click Next: Preview your letters.

snddressBlocks

I really love your musict

Diave

=

Mail Merge T

Write your letter

If yau hawe not already dane
50, wrile your letter now.

To add recipient information
to your letter, chick a location
in the dogument, and then

elick ane of the tems below.

E: Address block. ..

B Greeting line..

EY Electronic postage..
Bl more tems...

When yau hawe linishad
writing your better, click Mext.
Then you can preview and
personalize each recipient’s
letter.

Step 4 qu
& Previous: Select recipients

[0 Preview your letter and click Next: Complete the merge.

5 [ Fa T

Mick Jagger
Rolling Stones

11 Elm St., Sticky Fingers, TX
11111

Dear Mick,
I really love your music!

Dave
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Mail Merge -

Preview your letters

One of the merged letters iz
previewed here. To preview
another letter, dick one of
the fallewing:
Recipient: 1 |

' £ % 1

[0 Find a recipient...
Make changes

You £an also change your
recpient lst

[ Editrecipient bst...

Exchude this recplent

When you hawve fimished
previewing your letters, click
Meat. Then you an print the
merged lethers or edit
individual letters to add
personal comments,

Step 5 of 6

pmpiet g

€ Previous Wi Med u.-izzir;! step



[0 Click Print to print your letters or Edit individual letters to further personalize some or
all of the letters.

MMail Merge Tk

e plle e e e e
FAzil PA=rge is rea.dy to
produsces wouar l=tteEr=s.

To prersomalize ywowr letters,
click "Ediit Indisicdiuosl Letters.”
Trris wwill o pErm & e

L T T L A o BT T L B e |
letiters. T mmealcos ciharnges o
@Il tEwe efters, Swwilcin Eeaack T
EFves oorigimal docum-eewt.

[ s T

E:'g.. Primvt...

Ef= Edit indiwicdual letiers. ..

Shep & of 5

WHfE— PFPrawsiodas! Presiewss prouwer letters
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Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 07: Microsoft Excel 1

Objective: The aim of this laboratory practical is to ensure that students are able to create
a worksheet, use functions, differentiate between absolute and relative cell
references and format their worksheets

Requirements: This project requires Microsoft Excel.

Lab File: No file is required for this project.

Task 1: Creating a Worksheet

1. Start Microsoft Excel

2. Enter the labels and values shown below:
H ©- B = = Lab07 EX 1-- EXCEL-PHONE CHARGES CALC..xlsx - Excel ? E - 0O X%
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Sign in
sy Calibri -l - == = =3 General 4 %ﬂonditionalFormattingv g‘“lnsert -2 f;_‘Yv
p D Eg- B I U~ A A == J- $-% GFormatasTablev E* Delete - m' i -
aste e
5 ~ L A e 3= - Al GCE” Styles - [=] Format ~ ¢ -
Clipboard Font [F} Alignment ' Number Styles Cells Editing -~
c12 . I v
A B C D E F G H 3 4 L |
Phone charges per roomate for february
2 |basic monthly service rate 20.44
3 |Long distance charges for each Roomate:
4 Musa Aisha John Grace
5 5.85 0.25 1.35 3.75
6 0.45 0.65 2.15 0.88
7 1.68 0.56 3.78 1.23
8 4.15 5.77 0.95
9 1.25 0.88
10 3.67 1.95
11 3.88
12 | Total long distance | _l
13 |share of basic Rate
14 |Total -
Sheetl | Sheet2 | Sheet3 () [ »
READY HH m o-——+ 100
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In cell C12, use the AutoSum button to calculate the sum of the cells in column C. Use
a similar procedure to calculate the long distance call totals for Aisha, John, and Grace
in cells D12, E12 and F12.

In cell C13, create a formula to calculate Musa's share of the 320.44 basic monthly
service rate by dividing the contents of ceil D2 (N20.44) by 4. Create a similar formula
for each roommate in cells D13, E13, and F13.

In cell C14, create a formula to calculate Musa's share of the total phone bill by adding
the contents of cell C12 to the contents of cell C13. Create a similar formula for each
roommate in cells D14, E14, and F14.

Change the contents of Cell A1l to Feb Phone.

Use the Undo button to change the label in cell Al back to the original wording.

Compare your worksheet to the one shown in the figure on the next page.

H ©- B = = Lab07 EX 1-- EXCEL-PHONE CHARGES CALC..xlsx - Excel ? B - 0O x
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Sign in
LT § Calibri -l A== = % General i E[%Conditional Farmatting = E‘“Insert = z = ’é“?'
D g~ B I U~ A A === - $-9% » [ZiFormatasTable~ % Delete - [¢]~ #f-

Pajte e = B 6 28 [7 cell styles - &l Format~ &~

Clipboard Font ] Alignment o Mumber & Styles Cells Editing S

G14 * fe v
A B € D E F G H J K L [«

1 |Phone charges per roomate for february

2 |basic monthly service rate 20.44

3 |Long distance charges for each Roomate:

4| Musa Aisha John Grace

5 5.65 0.25 1.35 3.75

6 0.45 0.85 2.15 0.88

7| 1.68 0.56 3.78 1.23

8 4,15 5.77 0.95

9 1.25 0.88

10 3.67 1.95

11 3.88

12 |Total long distance 7.78 10.53 13.05 13.52

13 |share of basic Rate 5.11 5.11 5.11 5.11

14 |TDtE|| 12.89 15.64 18.16 18.53' .l =

Sheetl | Sheet2 | Sheet3 @ 4 »

)2

READY i M -—F—+ 100
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9. Save your worksheet in your project folder using the file name YourRegNo-cosc101-

Lab07-EX 1, where YourRegNo is your University Reg. Number

10. Copy the file to your flash and submit to your instructor.

Task2: USING FUNCTIONS

In this project, you'll apply what you've learned about AutoSum plus the MAX, MIN,

AVERAGE, and IF functions to complete a Microsoft Excel worksheet.

Requirements: This project requires Microsoft Excel.

Lab File: Lab7EX-2.xIsx

1. Copy the file Lab7EX-2.xIsx from Excel Lab Files folder on the desktop to your

Project folder. The file should look like the figure below;

H ©- " O = = Lab07 EX 2--EXCEL--DANGOTE AERO GROUP FLIGHT CALC. xlsx... ? B - 0O X
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Sign in
C T Arial '.:11} || == e =3 General b %Conditional Formatting ~ E‘“Insert A #H
D g~ B I U~ A A === - $ - 9% » [FFormatas Table~ EX Delete - .
Paste 2 Editing
- ~ B e A &= 3= - 0 9 [Z¥ Cell Styles - =] Format ~ .
| Clipboard = Font P Alignment M Mumber T Styles Cells -
H3 = fx v
A B C D E F G H -
5
111 DANGOTE AEREO GROUP
] 2 ABUJA Air KANO Air
3 |Destination Number of Flights |Number of Flights |MOST FLIGHT | )
4 |Lagos 125 135
5 |Enugu 157 143
6 |Bornu 225 221
j 7 |kaduna 218 235
| & [Miger 93 101
1 9 |Bayelsa 87 85
10 |Sokoto 124 137
11 [Total
12 |[Minimum
13 |[Maximum
14 |Average
15
16 |No. of States o
Bereo | Source | Sheet3 | & a0 ¥
READY 2| M -——+ 0%



Start Microsoft Excel
Open the file Lab7EX-2.xlsx from your Project Folder.
Click cell B11 and Use the AutoSum button in Home Tab, Editing group to

display the total number of flights, and similarly in C11.

In cell B12, Type the formula =MIN(B4:B10) function to display the lowest
number of ABUJA Air flights from the list that begins in cell B4 and ends in cell

B10. Enter a similar function in cell C12 for KANO Air flights.

In cell B13, Type the formula =MAX(B4:B10) function to display the highest
number of ABUJA Air flights from the list that begins in cell B4 and ends in cell

B10. Enter a similar function in cell C13 for KANO Air flights.

In cell B14, Type the formula =AVERAGE (B4:B10) function to display the
average number of ABUJA Air flights from the list that begins in cell B4 and ends

in cell B10. Enter a similar function in cell C14 for KANO Air flights.

In cell D3, enter the label Most Flights and adjust the column width so the label

fits in a single cell.

In cell D4, Type the formula =IF (B4>C4,"KANO AIR","ABUJA AIR")
Logical button in the Function Library group on the Formulas tab to create an IF
function that compares the number of flights for ABUJA Air and KANO Air. The
IF function should display KANO Air in cell D4 if that airline has the most flights
for Lagos and It should display ABUJA Air in cell D4 if that airline has the most
flights. (Hint; Place quotation marks around "KANO Air" and "ABUJA Air" when
you create the function, and remember that the Insert Function dialog box provides

help and examples.)
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10.

11.

12.

Use the Fill option in the Editing group on the Home tab to copy the IF function

from cell D4 down to cells D5 through D10.

In cell B16, Type the formula =Count(B4:B10) Count function to display the

number of destination States for ABUJA Air flights from the list that begins in

cell B4 and ends in cell B10. Enter a similar function in cell C16 for KANO Air

flights.

Enter your name in cell E1.

13. Compare your worksheet to the one shown in the figure on the next page, but don't

14.

save it yet. You have one change to make in Step 14.

H ©- 0O = 5 Lab0OV EX 2--EXCEL--DANGOTE AERO GROUP FLIGHT CALC (version 1) xls...
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

T Arial =10 == = ?f‘ General .| %Conditional Formatting = E‘“Inser‘c =
b Itﬁ g~ B I U~ A A =E== ~ $ - % * [FromatasTabler & Delete ~

asie T

i ¥ - DA~ &= 3= | B i a0 [7 Cell Styles - =] Format -
Clipboard Font ] Alignment ' MNumber R Styles Cells
D16 b Fe

A B C D E G
1 DANGOTE AEREO GROUP
2 ABUJA Air KANO Air
3 |Destination Number of Flights [Number of Flights |MOST FLIGHT
4 |Lagos 125 135|KANO Air
5 |Enugu 157 143|ABUIA Air
§ |Bornu 225 221|ABUIA Air
7 |kaduna 218 235|KANO Air
§ |Niger 93 101|KANO Air
9 |Bayelsa 87 88|KANO Air
10 |Sokoto 124 137|KANO Air
11 | Total 1029 1060
12 [Minimum 87 88
13 [Maximum 225 235
14 |Average 147 151.4285714
15
16 |[No. of States 7 7
Aereo | Source | Sheet3 ® 4

READY  RECOVERED

Change the number in cell C9 to 85
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11. Save your worksheet in your project folder using the file name YourRegNo-cosc101-

Lab07-EX 2, where YourRegNo is your University Reg. Number.

15. Use one of the following options to submit your project on a USB flash drive or as a

printout, or as an e-mail attachment, according to your instructor’s directions.

Task3: USING ABSOLUTE AND RELATIVE REFERENCES

In this project, you’ll apply what you have learned about absolute and relative references

to complete a sales commission worksheet.
Lab File: Lab7EX-3.xIsx

Copy the file Lab7EX-3.xlsx to your project folder on this page.

Y

H - O = = Lab07 EX-3-- EXCEL- COMMISSIOMN WKSHT arlsx - Excel ? A - B0 X
HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Sign in
"D 3% Arial -l | == e % General T %ConditionalFormatting' E' %
Ezy~ B I U ~ b a === - - ] =
B B u AN =E==H $ - % » [ Formatas Table Cells Editing
.o - - A == - Py 7 Cell Styles - : 5
Clipboard Font P Alignment . MNumber & Styles -~
B2 e A || 0.02 v
A B C D E F =
1 Commission Worksheet
2 |Commission Rate: | 0.02]
3
4 |Salesperson Rufai, Kabir John, Habiba Musa, Mohd James, Rose
5 Week 1 NGM 14,283.00 MNGM 11,020.00 NGMN 13,477.00 NGN 12,405.00
6 Week 2 NGM 17.808.00 MNGM 1238100 MNGMN 110000 NGN 1288900
7 |Week 3 NGMN 12,302.00 MNGM 1483000 NGN 13 747.00 NGN 14.700.00
8 Week4 NGM 13,100.00 MNGM 19,787.00 NGMN 18,483.00 NGN 15,806.00
9 |Total Sales NGM 5743300 MNGM 58,018 00 NGN 46 807.00 NGN 55.800.00
10 |Sales Commission NGN 1,149.86 NGN 1,160.36 NGHN 936.14 NGN 1,116.00
11 |Base Salary NGHM 500.00 NGM 501.00 MNGHM 502.00 NGHM 503.00
12 | Salary Plus Commissio NGN 1.649.86 NGM 1,661.36  MGM 1,438.14  NGN 1,619.00
13
14 NGN = ¥
Sheeti () 1 3
READY H M -—3F———+ 100

2. Start Microsoft excel.
3. Open the file Lab07 EX-3.xlsx from your project folder.

4. Notice that cell B2 contains a sales commission rate. Each salesperson receives a
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commission equal to his her total sales multiplied by the commission rate. The
commission rate changes periodically. The worksheet is set up so that if the sales
manager changes the rate in cell B2 all the sale commissions will be recalculated.
Create a formula in cell B10 by typing the formula =B9*$B$2 and click enter to
calculate the sale commission for column B, i.e. multiplying the total sales in cell B9
by the commission rate in cell B2. (Hin: you must use an absolute reference for the
commission rate in the formula).

Copy the formula from cell B10 to cells C10 through to E10.

Check the results of the copied formulas to make sure that they show the correct
results. If cell C10 through E10 contain zeros, you did not use the correct absolute
reference for the formula that you entered in step 5. If necessary, modify the formula
in B10 by typing =B10*$B$2 and click enter, then recopy it to cells C10 through
E10

Compare your worksheet to the worksheet shown in the figure on the next page, but

don’t save it until you complete step 9 and 10.

H ©- O = = Lab07 EX-3-- EXCEL- COMMISSION WKSHT xlsx - Excel ?2 B - 0O
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Sign in

LT 4 Arial -lo -|| == = % General T E[%Conditional Formatting - iil %

D BB- B I U- A A =S==E-%-% L‘?Format as Table = "
Paste Cells  Editing

. - e A E = B %8 M 7 Cell Styles - H £
Clipboard Font P Alignment P Mumber P Styles

B2 b I 0.02

A B & D E F
1 Commission Worksheet
2 |Commission Rate: | 0.02]
3
4 |Salesperson Rufai, Kabir John, Habiba Musa, Mohd James, Rose
5 Week1 NGM 14.283.00 MNGN 11,020.00 NGN 13,477.00 MNGM 12.405.00
6 Week 2 NGM 1780800 MNGN 1238100 MNGN 110000 MNGM 12 889.00
7 Week3 MNGM 12,302.00 NGHN 14, 83000 NGMN 13,747.00 MNGHM 14,700.00
g Week4 NGM 13.100.00 MNGN 19,767.00 NGMN 18,483.00 MNGM 15,806.00
5 Total Sales NGM 57 493.00 MNGN 58.018.00 MNGN 46,807 00 MNGM 55 80000
10 | Sales Commission NGN 1,149.86  NGN 1,160.36 NGN 936.14  NGN 1,116.00
11 Base Salary NGM 500.00 MNGM 501.00 NGHM 502.00 NGM 503.00
12 | Salary Plus Commissio NGM 1,649.86  MGMN 1,661.36 NGN 1,435.14 MNGN 1,619.00
13
14 NGN =N
Sheet1 @ 1 ’

READY HH f -——+ 0

ole]




9. Change the contents of the cell B2 to 0.03

10. Enter your name in cell B3

11. Save your worksheet in your project folder using the file name YourRegNo-cosc101-

Lab07-EX 3, where YourRegNo is your University Reg. Number.

12. Use one of the following options to submit your project on a USB flash drive, as a

printout, as an e-mail attachment, according to your instructor’s directions.

TAKE HOME EXERCISE

Task 4: Formatting a Worksheet

In this exercise, you'll apply what you've learned about Microsoft Excel to complete and

format a worksheet.

Requirements: This project requires Microsoft Excel.

Lab File: Lab07 EX-4.xIsx

Copy the file Lab07 EX-4.x1sx to your Project Folder on this page.

H 0
HOME | INSERT

PAGE LAYOUT FORMULAS DATA REVIEW VIEW

T & Arial -0 - T == E General - %Conditional Formatting - E‘“Inser‘t - - ’é‘?v
2 D fg- B I U- A A === - $ - 9% » [FFormatasTable~ £ Delete - [¢]~ #f-

aste )

- -4 - DA~ & 3= - %0 0 (57 Cell Styles -  Format~ & -
Clipboard ™ Font [F] Alignment ' MNumber Styles Cells Editing
BS T I Sales

A B C D E F G
1 |Income and Expense Summary
2
3 |Income Previous  Current  Increase % Increase
4 Misc. Inco 1450 2208 758 0522758621
5 |Sa|es _I 53200 72850 19650
6 Total 54650
7
8 |Expenses
9 Salaries 22180 23850 1670
10 | Inventory 18462 24502 6040
13| Rent 4500 5250 750
12 Advertising 2240 3810 1570
13 Misc. 1860 2602 742
14 Total 49242 60014 10772
15 |Profit 5408
Sheeti O] 4 3
READY i M -———+ 0%

Lab07 EX-4-- TAKE HOME- INCOME 8¢ EXPEMSES SUMMARY xlsx - Excel
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Start Microsoft Excel.

Open the file Lab07 EX-4.xIsx from your Project Folder.

Click the empty block between the "A" and "1" labels in the upper-left corner of the
worksheet to select the entire worksheet.
Change the font size of the entire worksheet to 12 point.

6. Copy the formula from cell C6 to cells 06 and E6.

7. Copy the formula from cell C15 to cells D15 and E15.

8. Copy the formula from cell F4 to cells F5 through F6, and cells F9 through F15.

9. Insert a new, empty row before row 15.

10.Change the color of the text in cell A1 to dark blue.

11. Change the font in cell Al to Times New Roman, size 14, bold.

12.Merge the contents of cells Al through F1 so that the title is centered across

those columns.
13.1In cell A2, enter today's date.

14.Use the Dialog Box Launcher in the Number group to open the Format Cells dialog
box. Select a date format that displays dates in the format Wednesday. March 14, 2010.
15. Merge the contents of cells A2 through F2 so that the date is centered.

16.Format cells A3 through F3 as bold text. Format cells A3 and A16 as bold text.
17.Format the numbers in cells C4 through E16 as currency.

18.Format the numbers in cells F4 through F16 as percentages (no decimal places).

19.Right-align the labels in cells C3 through F3.

20.Add both inside and outline borders to two cell ranges: B4 through F5 and B9
through F13.
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21.Adjust the width of all columns so that all labels and values fit within the cells.

22.Now, explore what happens when you align some of the worksheet labels at a 90°
angle. Select cells C3 through F3. Click the Orientation button in the Alignment group,
and then click Angle Counterclockwise.

23. Aligning column headings at a 90° angle is useful for worksheets that have many
narrow columns. On this worksheet, however, the labels looked better at the normal
angle, so use the undo button to the quick access toolbar to undo the 90° angle.

24.Compare your worksheet to the one shown below

H ©- 5 Lab07 EX-4-- SCO PRACTICE-TAKE HOME- INCOME & EXPENSES SUMMARY xlsx.. 27 B - O X

HOME PAGELAYOUT ~ FORMULAS  DATA  REVIEEW  VIEW Sign in
oy ¥ Arial == = B General " EﬂonditionalFormattingv E‘“Insert - - ’é‘?v
Pa:@ Eg-|B I U~ A A === - % -9% » [ramatasTable~ EX Delete ~ [V~ @~
. W - DA~ &= = - iR (7 Cell Styles~ & Format~ & -
Clipboard & Alignment & Mumber R Styles Cells Editing A
J12 v v
B G D E F «

1 Income and Expense Summary

2 Thursday, March 21, 2019

3 |Income Previous Current Increase % Increase

4 Misc. Income|NGN 1,450.00 NGN 2,208.00 |NGN 758.00 52%

5 Sales NGN 53,200.00 NGN 72 650.00 |NGN 19,650.00 37%

6 Total NGN 54,650.00 NGN 75,058.00 NGN 20,408.00 37%

A

3 [Expenses

9 Salaries NGN 22 180.00 NGN 23,850.00 |NGN 1,670.00 8%

10 Inventory NGN 18 462 .00 NGN 24 502 .00 |NGN 6,040.00 33%

11 Rent NGN 4,500.00 NGN 525000 |NGN 750.00 17%

12 Advertising |[NGN 2 240.00 NGN 3,810.00 |NGN 1,570.00 70%

13 Misc. NGN 1,860.00 NGN 260200 |NGN 742.00 40%

14 Total NGN 49242 00 NGN 60,014.00 NGN 10,772.00 22%

15

16 | Profit NGN 5,408.00 NGN 15,044 00 NGN 9,636.00 178%| -

*® ] 3
READY H f -—F—+ o

12. Save your worksheet in your project folder using the file name YourRegNo-cosc101-

Lab07-EX.4, where YourRegNo is your University Reg. Number.

25.Use one of the following options to submit your project on a USB flash drive or
floppy disk, as a printout, or as an e-mail attachment, according to your instructor’s

directions.
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Objective:

Ahmadu Bello University, Zaria

Department of Computer Science
COSC101: Introduction to Computing

Ahmadu Bello University, Zaria

Laboratory for Week 08: Microsoft Excel 2

The aim of this laboratory practical is to ensure that students are able to

prepare their worksheets for final printing and create charts.

Lab File: Lab08 EX-5.xlsx

Task 5: Finalizing a Worksheet

Copy the file Lab08 EX-5.xIsx to Project Folder.

B

)

Lah08 EX-5-- [Read-Only] - Excel [Product Activation Failed)

T E -0 X

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Signin
7] M
D Al To g x == = P E‘ General - Conditional Formatting = E““\n:ert * 2 - %‘Y H]
b EE . $ - % » [Formatas Table- S Delete + [¥]- e —

a- f BIU-|E-Q- hlSSSEE T ECEH Styles~ EI Format - o Fiter' S;.Tect'
Clipboard Font [F Alignment i Number & Styles Cells Editing i
K18 v fi v

A B c D E F H K L -
1 Dodo's 'Parking Store' Collection
2 |Description Product Size Weight Price  Shipping
3 |D-Magi Star 994 3"WxT'H 3 51095 $5.95
4 |D-Magi Knor 741 3I'WxT'H 7 51995 $5.95
5 |D-Magi Royco 561 3"Wx5"H 4 3295 $5.95 Discount Schedule
6 | D-Maggi Doyin 73 I"WxT'H 5 §19.95 $5.95 Qry Discount
7 |D-Magi Chicken 810 2'Wxd'H 9 51495 $5.95 510 10%
8 |L-Magi Star Etra 731 3'Wxd'H 7 $15.95 $5.95 11-20 20%
9 |T-Magi Star Super 735 3'Wxd'H 11 §12.95 $5.95 214 30%
10 |G-Magi Knor Extra 736 3"Wxd"H 14 529.95 $5.95
11 |K-Magi Royco Extra 777 3"Wxd'H 7 82195 $5.95
12 |G-Magi Doyin Extra 782 3"Wxd'H 11 §22.95 $5.95
13 |G-Magi Chicken Extra 792 3'Wxd'H 18 §12.95 $5.95
14 |K-Magi Knor Super 721 4"Wx2'H 19 53295  $595
15 |G-Magi Royco Super 824 4"Wx2'H 15 853495  §5.95
16 |Ancent Magi Doyin Super 872 4"Wx2'H 16 §32.95 $5.95
17 |Medium Mothercare Comnflake 875 3"Wx3'H 15 §29.95 $4.95
18 |Medium Fathercare Comflake 876 3"Wx3'H 1.5 $23.95 $4.95 |

1.

Start Microsoft Excel and open the file Lab08 EX-5.xIsx from your Project Folder.

2. Notice that when you scroll the worksheet, the title and column headings are no

longer visible. To freeze the titles at the top of the screen, click cell A3. You’ve

clicked this cell because you want the titles above row 3 to remain fixed in place

when you scroll.
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10.

11.

12.

13.

Click the View tab, click Freeze Panes in the Window group, and then select
Freeze Panes. Now scroll the worksheet and make sure that rows 1 and 2 remain in
view.

Scroll down the worksheet and notice that data for Miniature collections is not
complete. Select cell B43 and use the Fill option and then Series option to
consecutively number the products. For example, The Miniature Hammer should
have a product number of 359 and the Miniature War Horse should be 381.

All of the miniatures are the same size, weight, price, and shipping cost. Use the
Fill command to duplicate the information from cells C43 through F43 for all
miniature Collections

Select cell B2. Use the Wrap Text button in the alignment group of Home Ribbon
to wrap the text.

Adjust the width of column B so that Product Number fits on two lines.

Right-justify the data in columns B through F, then center the titles of those
columns.

Sort the data in cells A3 through F68 in A to Z order by Description i.e. using
Custom sort of Editing Group under Home Ribbon.

Check the spelling of the worksheet and correct misspellings as needed using F7
function.

Unfreeze the panes so that you can scroll the entire worksheet by reversing task 3
above.

Add a right-justified header to the worksheet that includes your name,
YourRegNo-cosc101-Lab08-EX.5, where YourRegNo is your University Reg.
Number and today’s date. Remember that: Header and Footer are under text group
of Insert Ribbon.

Add a centered footer to the worksheet that includes the word page followed by the
page number. Hint: If you can’t see header and footer elements such as Page
Number, select the Design tab.
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14.

15.

16.

17.

18.

19.

20.

21.

22.

Switch back to Normal view and check the Print Preview to see how this worksheet
is set up to print. Does it print all the Miniature Collections? What’s printed on the
second page?

Click on back arrow at the top left hand corner of the page and look at the current
print area, Al: 143. Part of the sheet is not included. Clear the print area so the
entire sheet will be printed.

Use the Margins options on the Page Layout tab to adjust the Width and Height
settings to print the worksheet on a single piece of paper. Print your worksheet.

The text on the single-page printout is quite small and let’s supposes that you don’t
want to print the Discount Schedule. On the Page Layout tab, change the width and
height to Automatic, and the scale to 100%.

Select cells A1 through F68 and designate this range as the print area, so that the
Discount Schedule is not printed.

Use the Print Titles button to designate cells Al through F2 as the title to print on
every page.

Using Sheet Options, designate that you want to print gridlines and headings so that
you can see the row numbers and column letters on the printout.

Set a page break at row 33. Hint: Select cell G33 before you click breaks button.

Look at a print preview of your worksheet. It should be similar to the two pages
below
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H S 0 Lab08 EX-5-- [Read-Only] - Excel (Prociuct Activation Failed) N s

FILE HOME ~ INSERT ~ PAGELAYOUT ~ FORMULAS ~ DATA  REVEW  VIEW  Team Sign in

J'f) 2 . Jg v ==@y. = General . %ConditionalFormamng' E“’Insert v Z' A
Paste 2 ‘:1 lI u | : & N = :: ,—F 3= bt EFWEH;TEME' E} peete - m Szor:Y& F[!di&
¥ MMM it 35 ECE”SMEV EFUWV 0 Fiter - Selet-
Clipboard & Font N Alignment G Number R Styles Cells Editing A
AdL Y jn, Medium Yorgurt v
A B c D E [
i Dodo's "Parking Store' Collection
2 Description Product Number Product Number Product Number Product Number
3 Medium Lux 878 3'Wx3'H | 15 $29.95
% Medium Mothercare Cornflake 875 3'Wx3'H 15 $29.95
% Medium Peak Milk 890 3'Wx3'H 15 $29.95
% Medium Ring-Sweet 892 3'Wx3'H ; 15 $29.95
7 MedumSuperlux  B43WdH 15 §2995
3% Medium Super Niddo Milk 888 3'Wx3'H | 15 $29.95
3 Medium Tissue Paper 893 3"Wx3"H 1.5 $29.95 |
4 Medium Tom-Tom Sweet 894 3'Wx3'H ; 15 $29.95
11| Medium Yorgurt 897 I'Wx3'H 15 $29.95
42 Miniature Painting 357 1"Wx1"H 0.5 $10.98
4 Miniature Bournvita 356 1"Wx1'H 0.5 $10.98
4 Miniature Carpet 360 1"Wx1"H 0.5 $10.98
45 Miniature Cooler | 375 1"Wx1'H | 05 $1098 -
Gargoyle ) 1] [1

B m-—4—+
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H 9 R s Lab0g EX-5-- [Read-Only] - Excel {Product Activation Failed) 1@ - 0 X

T HOME  INSERT  PAGELAVOUT  FORMULAS  DATA  REVEW  VEW  Team Signin
% - =—y. = |Generl - %ConditiunalFurmatting' E"Insert v |2 A

s B . L - ; z %?_} B $+%> QFormatasTab\e' E" Delete ~ ' Sz;r:Y& Ffdi&

o |V L fe 8- A-EE=E€EE Q- R ECEIISh,r\es' @Furmat' &7 Fiterr Select »
Clipboard & Font & Alignment G MNumber 5 Styles Cells Editing A
A b ﬁ Ancent Magi Doyin Super v

A B C D E <

1 Dodo's 'Parking Store' (;?uﬂection
2 Description Product Number Product Number Product Number Product Number
7 |Ancent Magi Doyin Super 872 4"Wx2'H 16 $3295
4 |D-Maggi Doyin 731 3'Wx7'H 5 $19.95
5 D-Magi Chicken 810 2"Wxd"H 9 $14.95
6 D-Magi Knor 741 3"Wx7"H 7 $19.95
7 D-Magi Royco 561 3"Wx5"H 4 $1295
8 D-Magi Star 994 3'Wx7T'H 8 $10.95
9 \G-Magi Chicken Extra 792 3'Wxd'™ 18 $1295
0/ G-Magi Doyin Extra 782 3'Wxd'H 11 $22.95
11 G-Magi Knor Extra 736 3'Wxd'™ 14 $29.95
12 G-Magi Royco Super 824 4"'Wx2'H 19 $34.95
13 K-Magi Knor Super 721 4"'Wx2'H 19 $3295
14 K-Magi Royco Extra 777 3"'Wxd'™H i $27.95
t5 L-Magi Star Etra 731 3"Wxd'H 1 $15.95 -

Gargoyle O) q 3

READY H M -———

23. Save your worksheet in your project folder using the file name YourRegNo-
cosc101-Lab08-EX.5, where YourRegNo is your University Reg. Number.
24. Submit your project on a USB flash drive, as a printout, as an e-mail attachment,

according to your instructor’s directions.
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Task 6: Creating Charts

In this project, you’ll apply what you’ve learned about Microsoft Excel to create a column

chart and pie chart for e-commerce worksheet.
Lab File: Lab08 EX-6.x1sx

I. Copy the file Lab08 EX-6.xlsx to Project Folder.
E’ s ﬁ s Lab08 EX-6-- [Read-Only] - Excel (Product Activation Failed)

HOME | INSERT ~ PAGELAYOUT ~ FORMULAS ~ DATA  REVIEW  VIEW  Team
[\ 0

Arial T2 A A === ¥ o z
: By~ ' § - %+ [fromatasTable~ X Delete + ¥ S
aste BIU-|Hi-b.A-l=Z==e=|8- e ot & Fin
v I A- SE=E€E i) QCE”STJ_HES' & formats £ - Filter = Select »
Cliphoard & Font M Alignment G Number & Styles Cells Editing A
B b fn, Business to Consumer v
A B C |DIE|F| G H J K L M 0 Fla

1
2 Primary E-commerce Business Activity  Projected Growth in Nig. E-commerce

3| Intemet Senvice 14% Years Billions
¢ Medialportals/publishers  16% 2003 110
5 Business to Business 18% 2004 230
6| [Businessto Consumer | 52% 2005 500
7] 2006 840
i 2007 1330
9] 2006 2500
10|

1|

12|

13|

14

f5 [ T[]

ECommerce | (%) q

A

General '%Conﬂonalhrmattin v Insert ~ v

TE-0X
Sign in

2. Start Microsoft Excel

3. Open the file Lab08 EX-6.xIsx from your Project Folder.
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10.

11.

Select the data in cells B3 through C6. Use the Insert tab to create a 3D pie chart.
Add the chart title, Which Activities Lead?, above the chart. Use the Data labels
(Data label is under Add Chart Element Drop Down command of Chart Layout Group
inside Design Ribbon) button to show percentages on the pie slices. Place the chart
on a new sheet and name the sheet Comparison Chart.

Change the style of the chart to style 3 in the Chart Styles group on the Design
contextual tab.

Change the chart background color to Subtle Effect, Accent 2 in the Shape Styles
group on the Format contextual tab.

Select the data in cells H4 through H9. Use the Insert tab to create a Clustered
Column chart. Click the Select Data button in the Data group on the Design
contextual tab. Click the Edit button for the Horizontal (Category) Axis Labels, then
select cells G4 through G9, click the Ok button to close the Axis Labels dialog box,
then click the Ok button to close the Select Data Source dialog box. Add the chart
title, Nig. Projections, above the chart. Add a vertical Y-axis title, ¥ Billions.
Remove the legend from the chart. Place the chart on a new sheet and name the sheet
Growth Chart.

Change the chart type to Line with markers in the Type group on the Design
contextual tab. Click the Ok button to apply the chart type.

Examine the charts to ensure that the spreadsheet data is accurately represented. One
easy verification technique is to identify a data trend and see if the trend is shown
both in the data and on the chart. A trend in this data is the trend for projected growth
to increase from one year to the next. Verify that the line chart corresponds to this
trend by making sure the line moves to the right.

Use care when identifying trend; make sure the conclusions you draw are accurate.
Be aware of what you can and can’t be concluded from data. For example, although
this data shows that 52% of e-commerce business activity is from business to
consumer, it would be incorrect to assume that 52% monetary transactions on a given
day are from consumers to businesses.

Copy both charts to E-Commerce tab.
Size and Position the pie chart so that the top-left corner of the chart is in cell A10 and

the bottom-right corner is in cell E23.
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12. Size and position the line chart so that the top-left corner of the chart is in cell G11
and the bottom-right corner is in cell L23.

13. Click a blank cell in the worksheet, and then open the Print Preview. Use Page Setup
options to change the page orientation to Landscape and fit the worksheet on one
page. The worksheet preview should look like the one shown in the figure below.

H

e

e
Primary E-commerce Bﬁess Activity Projected G rowth in Nig. E-commerce

Internet Service 14% “Year & Billion:
Media/portals/publishers 16% 2003 110
Business to Business 18% 2004 250
Business to Consumer 52% 2005 500
2006 240
2007 1330

Which Activities Lead? Mig. Projection

W imb=rnetse rvios 200
4%, 14% 2006

16%, 165% A R e E 2oas
9 4 ek ]

18, 18% Bisiness to - R
BEinEss 003
W Eusiness to 2ooz

ComEumeEr

52%, 52

14. Save your worksheet in your project folder using the file name YourRegNo-cosc101-
Lab08-EX.6, where YourRegNo is your University Reg. Number.

15. Submit your project on a USB flash drive, as a printout, as an e-mail attachment,

according to your instructor’s directions.
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Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 09: PowerPoint 1

Laboratory Objectives: The aims of this laboratory is to enable student create high quality
power point presentations for viewing using overheads, on-screen or printing with
presentation graphics problems.

Instructions to Student

You are expected to submit your completed exercises to your Lab
instructor before you leave the lab class. Your instructor will advise
you how to submit completed exercises.

Laboratory Exercises:

Starting Power Point 2013
1. Start Microsoft 2013

There are variety of ways to start using PowerPoint software. You can click on a
shortcut on your desktop or task bar. You can also click on Start>All
Programs>Microsoft Office>PowerPoint. In windows 7 and above, you can click on
the Start orb and type PowerPoint in the search box in the top left corner and select
PowerPoint from the list of choices that appears.

This display a blank Microsoft PowerPoint window

Click to add title

Click to add subtitle




Creating a New Presentation

2. Create a new presentation by
v" Clicking on the File tab.
v Clicking on New

This display a window

Neww

Click on Blank Presentation or one of the themes and continue which will display a window
as shown previously.

3. Saving a Presentation

Save the new presentation with the name YourRegNo-COCS101-Lab09-10, where
YourRegNo will be your registration number e.g “UI2MTI1212-COCS101-Lab09-
10" in your Personal folder at My Documents folder. Save the presentation in the
default format PowerPoint Presentation.

4. Click into the predefined text areas (placeholders). Type the text “Ahmadu Bello
University Zaria at a Glance “in the Click to add title area. Similarly, you can insert
your name in the Click to add subtitle placeholder

) : Ahmadu Bello University at a
: Glance

4 By
Ibrahim Muhahmad




Adding New Slide to the Presentation

5. Add nine more slides to your presentation using the mouse for the first four, and
keyboard the remaining five slides. Choose appropriate slide layouts for each slide.

EHS 0B ourfeg
HOME INSERT DESIGN “TRANSITIONS ANIMATIONS SUIDE SHOW

B 3 Cut =) Ellayout-

You [Product Activation Failec)

Reset

s ; Click to add title §

* Click to add text

supezoF10 DR  ENGLISH UNITED INGDOM)

= §L§|x§ E@ ) &

Working with Content
6. On the slide #two, type “Background” in the slide title placeholder.

7. Copy and paste textl from file xxx.doc contained in the folder yyy at the desktop, into
the placeholder for content

BHS &5 e — ;
B cve et ey taesmons Ao soeson ey Wy samin [0

Background

+ The preparations for the establishment of Ahmadu Bello University

3 = (ABU) started in 1961 with the recommendation for a University for
the Northern Region, by the Ashby Commission, set up by the
Carnegie Corporation, to look into “Post School Certificate and Higher
Education in Nigeria”.

Working with Content (2)
8. Similarly, on slide #three, type “Background (2)” in the slide title placeholder.

9. Copy and paste text2 from the same file xxx.doc into the content placeholder.
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BEHS OTF

sty od a T®E - 8 X
FOME | NG DESGN TTASTON | AVWATONS  SOLEOR fovew new s Y
X M Fing
25c Replace =
B 1] [ Select~
fort Pagagn orasng tatig -

. . B : 1 a . s

3 Background(2)

* In April of that year, the Northern Nigerian Legislature passed a law
3 B establishing a Provisional Council for the University. The council itself
= = was constituted in November, 1961 under the chairmanship of Sir
Kashim Ibrahim KCMG, CBE.

4

5

& .

supEsorio [ EnGusHp

A e ) = v CEEG

Working with Content (3)
10. On slide #four, type “Background(3)” in the title placeholder

11. Copy and paste text3 in the content placeholder from same file.

GO NS DGN TASTONS  AMWTONS  SLDESioW e o
) | Etara-
= v

Shde~

i Background(3)

* The University took its name after the then Sardauna of Sokoto and
3 X H Premier of Northern Nigeria, Sir Ahmadu Bello (1901-1966), who then
== became the first Chancellor and performed the opening ceremony on
4 October, 1962.

EFEA2 > = v OF

Working with Content (4)
12. On slide #five, type “Background(4)” in the title placeholder

13. Copy and paste text4 in the content placeholder from same file.
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™ = i
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2 Background(4)
* Sir Norman Stanley Alexander, a New Zealander and a Professor of
3 = Physics at the University college Ibadan, was appointed the first
Principal, (later Vice Chancellor)
4
6 :

supEsofio [F e

Working with Content (5)

14. On slide #six, type the text “Physical structure at inception” in the slide title place
holder

15. Type also the text5 exactly as it is. (Do not copy and paste as in the previous slides)

INSERT  DESIGN  TRANSTIONS

= Mg
%icReplace -

I Sedect -~

Esiting “

. Physical structure at inception
The University commenced full operation in 1962 with the following
5 d physical structures:
+ The defunct Nigerian College of Arts, Science and Technology,
5 founded in 1955
6 . + The Clerical training Centre, Kongo, founded in 1957

w * The Samaru Agricultural Research Station, established in 1924
+ The Shika Livestock Farm established in 1928.

suDEGDF10 (3 D KINGOOM)

= c Eraa > = v O

Working with content (6)

16. Insert the Audio clip title “yori yori” in slide #one. The clip is in the folder yyy.
Format the audio clip such that it plays across all the slides automatically.

Formatting Text

17. Select the text in the content placeholder of the slide #two
18. Change the font typeface to Harlow solid italic

19. The font size to 36 points

20. The font color to dark blue
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Formatting Text (2)
21. Select the text in the title slide (slide #one) i.e the title of the presentation.
22. Change the text to wordArt

23. Format the wordArt further to look like the one on the image

BHS 07+ T TE -8 X
QO rove  WSERT RSN TRANSTIONS  AMMATIONS  SUDESHOW  REVIEW  VIEW signin [0
- =] B hape e Find
= d 2 Reset - e Repiace
[ Hew S W . :
ol Side- '8 Section d g 1 Seleet+
Cipbasia 5 sies Font Faraginh Orawing caiing ~
2] 0 1 ] 2 i f 4 8 =
1
2

L du BeHoUnwefSM’ata
Tl nmade ¥ e

By
P
- . - Ibrahim Muhammad
5 ”
n ;
- s
6

Graphics
24. Change the slide layout of slide #two, #three and #four to two content layout.

25. Insert images of senate Building in the other placeholder of slide #two, Kashim
Ibrahim in that of slide #three, Sir Ahmadu Bello in slide #four and Prof Alexander in
slide #five from folder yyy at desktop.
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Graphics (2)

26. Give each image inserted on slide #two, #three, #four and five appropriate frames as
shown in the image

BEHS 0T« 2 m -8 ox
BEE o SeT  DESGN  TRANSTIONS  ANIMATIONS  SLDESHOW  REVIEW  view signin [0
o~ [ ot e
h-i' g =i P y 2 Suge O 2 Replace -
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1 s 3 2 o 5 3
i Background(4)
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* Sir Norman Stanley Alexander, a
2 New Zealander and a Professor
of Physics at the University
college Ibadan, was appointed
- ko the first Principal, (later Vice
ey @ Chancellor).
5
:
- wtae

Click to add notes

Graphics (3)
27. On slide #seven, use SmartArt Graphics to list the names of the last two Vice

Chancellors and the current Vice Chancellor along with their photograph shown in the
image.
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Adding a text box

28. Add text boxes under the images on slides #two, #three, #four and #five.

29. In each text box type the name of the person whose image is displayed as shown.

EHS 0% Yourk ion Failec)
HOME | INSERT  DESGN  TRANSTIONS  ANMATIONS SUDESHOW  REVEW  VIEW
e

™y O shapeFil~ #Fnd
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Headers and Footers

30. Insert a date on all the slides such that it updates automatically.

31. Insert slide numbers on all the slides.

32. Insert the footer “© Ahmadu Bello University, Zaria” on all the slides.
Applying a Theme

33. Apply Solstice theme to the presentation
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34. Try any other two different theme from the collection and decide on which best fit
your presentation.

35. Apply also different themes to different slides.

m H® 05+ YourRegNo-COCS101-Lab09-10 - PowerPoint (Product Activation Failed) THE - X
Gl HOME  INSERT | DESIGN ~ TRANSITIONS ~ ANIMATIONS ~ SLDESHOW  REVIEW  VIEW Signin |}
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Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 10: Inserting Tables and Charts, Inserting Clip Art, Grouping
objects on the slide, Adding Transition and Animation Effects, Running Slide Show

Tables
22. On slide #eight type “A.B.U. Zaria student admission 2006-2010” as the slide title.

23. Insert a table with the following hypothetical data representing the number of
admitted students in ABU between 2006-2010

2006 2500 3500
2007 3500 4800
2008 4300 6500
2009 4660 7500
2010 4800 6500
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Charts
24. On slide #nine, insert a column chart representing the data on the table of slide #eight.

25. Format the chart as shown in the image.
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Grouping Clip Art, Picture and Text Box

26. On slide #ten, insert the ABU logo from the yyy folder, the Ribbon from Clip Art
gallery and a text box.

27. Type “Centre of excellence” in the text box

28. Format and arrange the three objects as shown in the image and hence group them.
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Slide transition effects

29. Apply transition effect to all the slides, try different effects to different slides.
30. Apply transition time of say 5 seconds to all the slides.

Slide animation effects

31. Apply custom animation to both text and other objects.

32. Run the slide show.......
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Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 11: Internet tools and Technologies

Introduction: This section provides the basic concepts of Internet.

Objective: The students will able to use:

1. Different browsers to search for information on the Internet.
2.Different Search techniques.

3.The browser’s menu and navigation bars.

Lab. Exercise 1:

1.Start your browser and have writing materials ready to write down answers to

questions posed in the steps. What is the URL of your Home page?

2.If your browser opens to site other than Google, type www.google.com in the

address bar and press the Enter key to connect to the Google search engine.

3.Enter “Friday Yakubu + correlation analysis of data rate and buffer size on

TCP performance using OPNET simulator” in the search text box.
4.Click on “Google Search” button.

5.0n the page displayed, identify the link: IJCA - Correlation Analysis of Data

Rate_and Router

Buffer Size on ... and click on the link
a. What is the URL of your Home page?
b. What is the title of the page?

c. Who are the authors of the journal paper?
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d. Identify the year, article number and article volume number.
e. Select and copy the Abstract of the journal paper.

6.0pen your Microsoft Word application and paste what was copied. Save the

file as: Friday’s journal.

7.Submit your script for assessment.

Lab. Exercise 2:

1.Start your browser and have writing materials ready to write down

answers to questions posed in the steps. What is the URL of your Home

page?

2.1f your browser opens to site other than Yahoo, type www.yahoo.com in
the address bar and press the Enter key to connect to the search engine.
3.Enter “Friday Yakubu + correlation analysis of data rate and buffer size on

TCP performance using OPNET simulator” in the search text box.

4.Click on “Search” button.

5.0n the page displayed, identify the link: Correlation Analysis of Data
Rate_and Router Buffer Size on ... and click on the link. What can you
say about the information displayed through Google and Yahoo?

6.Add this page to your favorites or Bookmarks. How many sites are listed
in your favorites or Bookmarks?

7.Select favorites or Bookmarks on the menu bar and click on organize
favorites or Bookmarks menu. On the displayed library dialogue
window, right-click on favorites or Bookmarks menu and create a new
folder called My sites.

8.Double-click on the favorites or Bookmarks menu; drag the site you
bookmarked onto the folder: my sites.

9.Use the Back button to return to the results of your yahoo search, then

select any of the links that shows: performance analysis of TCP in a
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reliable ..... and click on it. Bookmarked the visited page into the created
folder: My sites.

10. Call the Lab. Lecturer for assessment and submit your script.

Lab. Exercise 3:

1.Use any of the browser and search engine to search for information on “Basic

search Tips ”.

2.Type: Basic search Tips in the search text box and search click on search

button.
3.Observe the result of the search.
4.Repeat the search by Typing: PDF + Basic search Tips.
5. Write down what you observe on the results of the two search techniques?

6.Search for information on Impact of ETP on education using the following

methods

a. Type: Impact of ETP on education in the search text box and

search click on search button.

b. Repeat search by Typing: * impact of ETP on education” in the

search text box and search click on search button.

c. Repeat another search by Typing: impact + ETP + education in

the search text box and search click on search button.

d. Search again by Typing: PDF + “impact of ETP on education”

in the search text box and search click on search button.
7. Write down your observation on the search techniques.

8.Submit your script for assessment
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Lab. Exercise 4:

1. Start your browser and have writing materials ready to write down answers to

questions posed in the steps.

2.Connect to the site www.ross-simons.com. Click the stop button. Did the

entire page load?

3.Can you access the site www.yahoo.com or www.google.com from your

History list? Explain why or why not.

4.Connect to www.e-course.com/megh/reservations.htm. Fill in the newsletter

form. Click the submit button to submit the form.

5.Go back to the site www.ross-simons.com.

6.Use the file menu to access the page Setup dialog box.
a. Change the paper orientation to landscape.
b. Change the top and bottom margins to “1”.
c. Change the left and right margins to “2”
d. Click the OK button to save settings.
7.Use the file menu to display a print preview.
8.Make sure that the information fits on two pages, then save on your flash disk.

9.Print out the information that was saved in a flash. 10. Submit a copy of the

print out for assessment
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Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 12: Internet tools and Technologies 2

Lab. Exercise 1:
1. Create a yahoo group for discussion. Hint: use the manual as guide, and follow the
instructions and steps to create a group.
2. Build membership for the yahoo group created in (1).
3. Send the file: “N Power” as note to the members of the group created in (1).
4. Post a topic: “benefits of having a yahoo group” to the members of the group created

in (1) for discussion.

Lab. Exercise 2:
1. Create a Google group for discussion. Hint: use the manual as guide, and follow the
instructions and steps to create a group.
2. Build membership for the yahoo group created in (1).
3. Send the file: “N Power” as note to the members of the group created in (1).
4. Post a topic: “benefits of having a yahoo group” to the members of the group created

in (1) for discussion.
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Ahmadu Bello University, Zaria
Department of Computer Science
COSC101: Introduction to Computing

Laboratory for Week 13: Working with E-mail

This section provides the basic concepts of E-mail and yahoo/Google grouping for discussion
on the Internet.

Objective: The students should understand and able to create an e-mail account and use to
send messages with attachment, and to create a group for discussion.

Lab. Exercise 1:

1.

»

5.
6.

If you don’t have an email address, Create a new email address

Start your browser

Type: www.yahoomail.com in the address bar

On the displayed page, click on the button title: Create New Account

A form page will be display. Fill the form and send it.

Note: if you did not provide the correct information, the page will be displayed
again for correction.

If you have an email address, start your browser and access your email account.
Create a new message to emaill.ab@yahoo.com.

Enter “email assignment” in the subject line and in the message area use your own
words to write a short message about the course.

At the end of the message, type your Reg.No and names as a closing

Send the message.

/oo

Lab. Exercise 2:

1.

2.

N

Access your email account, open the message sent from emailLab@yahoo.comand
read it.

Add the sent message email address to your address box by right-clicking the From
box and selecting add to contacts from the pop-up menu.

. Compose a reply to the sent message, but don’t send off the reply just yet. Look at

your Inbox and open a second message. Highlight the most important sentence, click
Edit on the menu bar and then click Copy. Switch back to the message you’re sending
and paste the sentence from the other e-mail message.

Create a document from Microsoft Word application and save the file as: email
attachment. You are free to type any script.

Insert the file email attachment as an attachment.

Send and close your email box.
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Exercise 3:

1. Use any of the search engines available and find information on “Fuel subsidy in
Nigeria”.

2. Summarize your point, not more than one page of a document. Use Microsoft Word to
save your summary, and name the file as: Fuel subsidy.

3. Compose a new email message attaching the file: Fuel subsidy, and sent to
emaill.ab@yahoo.com
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